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1 Ειςαγωγή 

ην παξόλ παξνπζηάδνληαη βαζηθέο εξγαζίεο δηαρείξηζεο ζπζηεκάησλ Windows 

ρνιηθώλ Δξγαζηεξίσλ. πγθεθξηκέλα παξνπζηάδνληαη ηα αθόινπζα ζέκαηα: 

1. Η ρξήζε θνλζνιώλ γηα ηε δηεπθόιπλζε δηαθνξεηηθώλ δηαρεηξηζηηθώλ 

δηαδηθαζηώλ. 

2. Η Γηαρείξηζε πκβάλησλ κε ρξήζε ηνπ Event Viewer 

3. Η Γηαρείξηζε πζθεπώλ κε ρξήζε ηνπ Device Manager 

4. Η Γηαρείξηζε Τπεξεζηώλ κέζα από ηελ θνλζόια Services 

5. Η ρξήζε ηνπ Remote Desktop γηα ηελ απνκαθξπζκέλε πξόζβαζε θαη 

δηαρείξηζε ζπζηεκάησλ 

6. Ο ρξνλνπξνγξακκαηηζκόο πεξηνδηθώλ δηαρεηξηζηηθώλ εξγαζηώλ κε ρξήζε 

ησλ Scheduled Tasks 

7. Η εμεύξεζε ζπζρεηίζεσλ κεηαμύ πξνγξακκάησλ θαη βηβιηνζεθώλ κε 

ρξήζε ηνπ Dependency Walker, κε ζθνπό ηελ αληηκεηώπηζε 

πξνβιεκάησλ ζηελ νξζή εθηέιεζε εθαξκνγώλ 

8. Ο Έιεγρνο δίζθσλ κε ρξήζε ηνπ εξγαιείνπ HD Tune 

9. Ο Έιεγρνο κλήκεο κε ρξήζε ηνπ εξγαιείνπ RMMA 

10. Ο έιεγρνο ησλ ζεκείσλ εθθίλεζεο πξνγξακκάησλ κε ρξήζε ηνπ 

εξγαιείνπ AutoRuns 

11. Η Γηαρείξηζε Γηεξγαζηώλ κε ην εξγαιείν Process Explorer, πνπ είλαη θαηά 

πνιύ αλώηεξν ηνπ Task Manager 

12. Δξγαζίεο Γνκεκέλεο Καισδίσζεο κε θαηαζθεπή θαη έιεγρν θαισδίσλ 

UTP Cat 5/5e 

13. Αζθήζεηο ζηα αλσηέξσ αληηθείκελα. 

Σν πιηθό ζπκπιεξώλεηαη από ηελ πξώηε ελόηεηα ησλ δηαθαλεηώλ ησλ 

εκεξήζησλ ζεκηλαξίσλ Τπεπζύλσλ ΔΠΔΗΤ (πζηεκαηηθέο Δξγαζίεο). 
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2 Κονςόλεσ Διαχείριςησ - MMC Consoles (Security 
Configuration and Analysis) 

Γηα ηελ πξαγκαηνπνίεζε ζύλζεησλ δηαρεηξηζηηθώλ εξγαζηώλ ζηα ππνινγηζηηθά 

ζπζηήκαηα Windows Server 2003 θαη Windows XP, αμηνπνηείηαη ε Microsoft 

Management Console (MMC). ηελ MMC κπνξνύλ λα ζπλδπαζηνύλ ηα 

απαξαίηεηα δηαρεηξηζηηθά εξγαιεία, δεκηνπξγώληαο έλα νινθιεξσκέλν 

πεξηβάιινλ ρξήζεο ηνπο. 

Σν MMC κπνξεί λα ρξεζηκνπνηεζεί κε δύν δηαθνξεηηθνύο ηξόπνπο: 

1. ζε user mode, όπνπ ήδε πεξηιακβάλεη έλα ζύλνιν βαζηθώλ δηαρεηξηζηηθώλ 

εξγαιείσλ, π.ρ. επηζθόπεζε ησλ ζπκβάλησλ ηνπ Λ (Event Viewer), 

Γηαρείξηζε Γηακνηξαδόκελσλ θαθέισλ (Shared Folders), Γηαρείξηζε 

πζθεπώλ πζηήκαηνο (Device Manager) θ.α. 

2. ζε author mode, όπνπ ν δηαρεηξηζηήο κπνξεί λα εληάμεη ηα απαξαίηεηα γηα 

απηόλ δηαρεηξηζηηθά εξγαιεία. 

ηηο επόκελεο παξαγξάθνπο παξνπζηάδεηαη ν ηξόπνο ρξήζεο ηεο MMC ζε 

author mode, γηα ηελ αμηνπνίεζε ηνπ εξγαιείνπ «Security Configuration and 

Analysis». 

Γηα λα θνξηώζνπκε θάπνηα MMC Console, ηξέρνπκε από Start → Run ην mmc: 

 

Δηθόλα 2-1 
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Δηθόλα 2-2 

Γηα ηελ πξνζζήθε κηαο MMC Console επηιέγνπκε File → Add/Remove Snap-In: 

 

Δηθόλα 2-3 
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Δηθόλα 2-4 

Παηάκε ην θνπκπί Add γηα λα δνύκε ηα δηαζέζηκα Snap-Ins: 
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Δηθόλα 2-5 

Γηα παξάδεηγκα επηιέγνπκε ην Snap-In “Security Configuration and Analysis”: 
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Δηθόλα 2-6 

Παηάκε ζην θνπκπί Add, κεηά ζην θνπκπί Close θαη θαηόπηλ ζην θνπκπί ΟΚ: 
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Δηθόλα 2-7 
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Δηθόλα 2-8 

 

Δηθόλα 2-9 
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Με δεμί θιηθ επηιέγνπκε ην Open Database: 

 

Δηθόλα 2-10 

Δπηιέγνπκε όλνκα γηα ηε database πνπ ζα δεκηνπξγεζεί: 
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Δηθόλα 2-11 

Δπηιέγνπκε template βάζεη ηνπ νπνίνπ ζέινπκε λα ξπζκίζνπκε ην ζύζηεκά καο: 

 

Δηθόλα 2-12 

Καηόπηλ δεμί θιηθ θαη επηιέγνπκε “Analyze Computer Now”: 
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Δηθόλα 2-13 

Δπηιέγνπκε θαηάινγν γηα ην log file: 

 

Δηθόλα 2-14 

ηελ επόκελε νζόλε εκθαλίδνληαη ηα απνηειέζκαηα ηεο αλάιπζεο. Με πξάζηλν 

είλαη όζα ζπκθσλνύλ κε ην template, κε θόθθηλν όζα δε ζπκθσλνύλ ελώ 

ελδέρεηαη λα ππάξρνπλ θαη επηινγέο πνπ δελ αλαιύζεθαλ γηαηί δελ ππήξραλ ζην 

template: 
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Δηθόλα 2-15 

Από ηελ επηινγή System Services, κε δεμί θιηθ ζε θάπνηα ππεξεζία επηιέγνπκε 

Properties: 
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Δηθόλα 2-16 

 

Δηθόλα 2-17 
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Παηώληαο ζην θνπκπί “View Security” βιέπνπκε ηελ θαξηέια Security γηα ηελ 

ππεξεζία: 

 

Δηθόλα 2-18 

Δπηιέγνληαο “Define this policy in the database” θαη θαηόπηλ παηώληαο ζην 

θνπκπί “Edit Security”: 
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Δηθόλα 2-19 

Μπνξνύκε λα αιιάμνπκε ηελ θαξηέια Security γηα ηελ ππεξεζία: 

 

Δηθόλα 2-20 
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3 Διαχείριςη Συμβάντων - Event Viewer 

Γηα ηε γξήγνξε επηζθόπεζε ηνπ αξρείνπ θαηαγξαθήο ζπκβάλησλ 

ρξεζηκνπνηείηαη ην εξγαιείν Event Viewer, κέζα από ηελ MMC ζε user mode. ε 

θάζε ζύζηεκα Windows πξαγκαηνπνηνύληαη θαηαγξαθέο γηα ηηο αθόινπζεο 

θαηεγνξίεο ζπκβάλησλ: 

1. Application 

2. Security 

3. System 

Αλάινγα κε ηηο επηπιένλ ιεηηνπξγίεο ή ππεξεζίεο πνπ είλαη εγθαηεζηεκέλεο ζην 

ζύζηεκα είλαη δπλαηόλ λα πξαγκαηνπνηνύληαη θαηαγξαθέο ζπκβάλησλ γηα 

πεξηζζόηεξεο θαηεγνξίεο, όπσο γηα παξάδεηγκα: 

1. DNS Server, γηα ηε ιεηηνπξγία ηεο ππεξεζίαο DNS, 

2. Directory Service θαη File Replication Service γηα ηε ιεηηνπξγία ηνπ Server 

σο Domain Controller. 

Κάζε θαηαγξαθή ζπκβάληνο θαηεγνξηνπνηείηαη σο πξνο ηελ θξηζηκόηεηά ηεο ζε: 

1. Λάζνο (Error) 

2. Πξνεηδνπνηεηηθό κήλπκα (Warning) 

3. Πιεξνθνξηαθό κήλπκα (Information) 

Γηα θάζε ζπκβάλ θαηαγξάθνληαη ηα αθόινπζα ζηνηρεία: 

1. Η θαηεγνξηνπνίεζε ηεο θξηζηκόηεηάο ηνπ 

2. ηνηρεία ρξόλνπ 

3. Η πεγή από ηελ πξνήιζε ην ζπκβάλ (ππεξεζία ή εθαξκνγή) 

4. Δπηκέξνπο θαηεγνξηνπνίεζε ηνπ ζπκβάληνο σο πξνο ηελ πεγή 

5. Αξηζκεηηθόο Κσδηθόο 

6. Ο ρξήζηεο γηα ηνλ νπνίν έηξερε ε εθαξκνγή ή ε ππεξεζία (SYSTEM) 

7. Ο ππνινγηζηήο ζηνλ νπνίν θαηαγξάθεθε ην ζπκβάλ 

Με δεμί θιηθ ζην My Computer θαη επηιέγνληαο Manage, κπνξνύκε λα έρνπκε 

πξόζβαζε ζην Computer Management MMC θαη από εθεί ζηνλ Event Viewer: 
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Δηθόλα 3-1 

Με δεμί θιηθ ζε θάπνηα θαηεγνξία Events θαη επηιέγνληαο Properties: 

 

Δηθόλα 3-2 

έρνπκε πξόζβαζε ζηηο ηδηόηεηεο απηήο ηεο ελόηεηαο ησλ Events: 
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Δηθόλα 3-3 

ηελ θαξηέια Filter κπνξνύκε λα εηζάγνπκε θξηηήξηα ώζηε λα πεξηνξίζνπκε ηνλ 

αξηζκό ησλ εκθαληδόκελσλ events θαη λα επεμεξγαζηνύκε επθνιόηεξα 

πιεξνθνξίεο γηα ζπγθεθξηκέλε ππεξεζία ή ρξνληθό δηάζηεκα: 
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Δηθόλα 3-4Δπηινγή events βάζεη ησλ ηδηνηήησλ ηνπο 
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4 Διαχείριςη Συςκευών - Device Manager (Hidden Devices) 

Από ην Computer Management κπνξνύκε λα έρνπκε πξόζβαζε θαη ζην Device 

Manager (devmgmt.msc), ώζηε λα δνύκε ηηο εγθαηεζηεκέλεο ζπζθεπέο. Μία 

ρξήζηκε δπλαηόηεηα είλαη ε αθαίξεζε από απηή ηε ιίζηα (άξα θαη από ην 

κεηξών), ζπζθεπώλ πνπ θάπνηε είραλ εγθαηαζηαζεί ζην ζύζηεκα, αιιά πιένλ 

έρνπλ απνκαθξπλζεί από απηό. Πξαγκαηνπνηείζηε ηα αθόινπζα βήκαηα: 

1. Κάληε δεμί θιηθ ζην εηθνλίδην Ο Τπνινγηζηήο κνπ (My Computer). 

2. Κάληε θιηθ ζηελ εληνιή Ιδηόηεηεο (Properties). 

3. Κάληε θιηθ ζηελ θαξηέια Γηα πξνρσξεκέλνπο (Advanced). 

4. Κάληε θιηθ ζηελ θαξηέια Μεηαβιεηέο πεξηβάιινληνο (Environment 

Variables). 

5. Οξίζηε ηηο κεηαβιεηέο ζην πιαίζην Μεηαβιεηέο ζπζηήκαηνο (System 

Variables). 

 

Δηθόλα 4-1 
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Δηθόλα 4-2 

Οξίδνπκε ηελ αθόινπζε λέα κεηαβιεηή ζπζηήκαηνο 

devmgr_show_nonpresent_devices ζηελ ηηκή „1‟: 

 

Δηθόλα 4-3 
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Δηθόλα 4-4 

Γηα λα κπνξέζεηε λα δείηε ηηο ζπζθεπέο πνπ δελ είλαη ζπλδεδεκέλεο ζηνλ 

ππνινγηζηή, θάληε θιηθ ζηελ επηινγή Δκθάληζε ησλ θξπθώλ ζπζθεπώλ (Show 

hidden devices) ζην κελνύ Πξνβνιή (View) ηεο Γηαρείξηζεο πζθεπώλ (Device 

Manager). 
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5 Διαχείριςη Υπηρεςιών - Services 

Από ην Computer Management κπνξνύκε λα έρνπκε πξόζβαζε θαη ζηηο 

Τπεξεζίεο (services.msc), ώζηε λα δνύκε ηηο ππεξεζίεο ηνπ ζπζηήκαηνο: 

 

Δηθόλα 5-1 

Δπηιέγνληαο θάπνηα ππεξεζία θαη παηώληαο δεμί θιηθ θαη Properties κπνξνύκε 

λα δνύκε ηηο ηδηόηεηέο ηεο: 
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Δηθόλα 5-2 

Από ηελ θαξηέια “Log On” κπνξνύκε λα αιιάμνπκε ην ινγαξηαζκό πνπ εθθηλεί 

ηελ ππεξεζία: 

 

Δηθόλα 5-3 
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Δηθόλα 5-4 

Από ηελ θαξηέια “Dependencies” είκαζηε ζε ζέζε λα δνύκε αλ απηή ε ππεξεζία 

εμαξηάηαη από άιιεο γηα λα εθθηλεζεί ή ρξεηάδεηαη λα ηξέρεη ώζηε λα εθθηλεζνύλ 

άιιεο ππεξεζίεο: 

 

Δηθόλα 5-5 
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Δηθόλα 5-6 

Πνιιέο θνξέο είλαη ρξήζηκν λα δηαηάζζνπκε ηηο ππεξεζίεο θαηά Startup Type 

ώζηε λα εληνπίδνπκε εθείλεο πνπ είλαη ηύπνπ Automatic, αιιά δελ έρνπλ 

μεθηλήζεη (δελ είλαη ζε θαηάζηαζε Started). Δλδερνκέλσο λα πξόθεηηαη γηα 

πξόβιεκα αλ εληνπίζνπκε θάηη ηέηνην, αλ θαη ππάξρνπλ πεξηπηώζεηο ηέηνησλ 

ππεξεζηώλ (π.ρ. Computer Browser, Security Center) πνπ δελ παξαπέκπνπλ ζε 

πξόβιεκα. 
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6 Remote Desktop 

Η απνκαθξπζκέλε πξόζβαζε κπνξεί λα εθθηλεζεί θαη κε ηελ εληνιή mstsc. Αλ ε 

εληνιή απηή ζπλνδεύεηαη από ην switch /console (/admin γηα Windows XP SP3, 

Windows Vista θαη Windows 2008) ηόηε ε ζύλδεζε πξαγκαηνπνηείηαη ζην 

ιεγόκελν console session ηνπ απνκαθξπζκέλνπ ζπζηήκαηνο. 

 

Δηθόλα 6-1 Δθθίλεζε απνκαθξπζκέλεο πξόζβαζεο 

ηηο επηινγέο, από ηελ θαξηέια Display κπνξνύκε λα αιιάμνπκε ηηο 

παξακέηξνπο ζρεηηθά κε ηηο ξπζκίζεηο νζόλεο γηα ηελ απνκαθξπζκέλε 

πξόζβαζε: 

 

Δηθόλα 6-2 Ρπζκίζεηο ιεηηνπξγίαο 
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Από ηελ θαξηέια Local Resources κπνξνύκε λα επηιέμνπκε αλ ζα κεηαθέξεηαη 

θαη ν ήρνο από ην απνκαθξπζκέλν ζύζηεκα θαζώο θαη πνηνη από ηνπο ηνπηθνύο 

πόξνπο (π.ρ. εθηππσηέο, δίζθνη) ζα είλαη δηαζέζηκνη ζην απνκαθξπζκέλν 

ζύζηεκα: 

 

Δηθόλα 6-3 Υξήζε ηνπηθώλ πόξσλ ζηνλ απνκαθξπζκέλν ππνινγηζηή 

Από ηελ θαξηέια Experience κπνξνύκε λα επηιέμνπκε πξνθίι αλάινγα κε ηελ 

ηαρύηεηα ηεο ζύλδεζεο ή θαη ζπγθεθξηκέλα ζηνηρεία πνπ ζα κεηαθέξνληαη, ώζηε 

λα είλαη νκαιή θαη απξόζθνπηε ε απνκαθξπζκέλε πξόζβαζε: 

 

Δηθόλα 6-4 Ρύζκηζε ιεηηνπξγίαο αλάινγα κε ηελ ηαρύηεηα ηεο δηθηπαθήο πξόζβαζεο 
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Από ηελ θαξηέια Advanced δηαζέηνπκε επηινγέο ηόζν γηα ην Server 

Authentication από ην απνκαθξπζκέλν κεράλεκα θαζώο θαη αλ ζα 

ρξεζηκνπνηεζεί θάπνηνο Terminal Services Gateway γηα ηελ απνκαθξπζκέλε 

πξόζβαζε: 

 

Δηθόλα 6-5 Ρπζκίζεηο απζεληηθνπνίεζεο θαη ζύλδεζεο κέζσ TS Gateway 
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7 Scheduled Tasks 

Με ηελ εθαξκνγή Scheduled Tasks κπνξνύκε λα ρξνλνπξνγξακκαηίδνπκε 

εξγαζίεο ζε ππνινγηζηηθά ζπζηήκαηα MS Windows. Η εθαξκνγή ελεξγνπνηείηαη 

από Start > Control Panel. 

 

Δηθόλα 7-1 

ην Control Panel αλνίγνπκε ηα Schedules Tasks (ή Task Scheduler ζε παιηόηεξεο 

εθδόζεηο). 
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Δηθόλα 7-2 

Πξνζζέηνπκε λέα ρξνλνπξνγξακκαηηζκέλε εξγαζία κε ηελ επηινγή «Add 

Scheduled Task». Έζησ πσο ζέινπκε λα θάλνπκε αλαζπγθξόηεζε ηνπ 

δίζθνπ/θαηάηκεζεο C: ζηνλ ππνινγηζηή καο θάζε κήλα. 

 

Δηθόλα 7-3 
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Δπηιέγνπκε next ζηελ επόκελε νζόλε. 

 

 

Δηθόλα 7-4 

Με browse εληνπίδνπκε θαη επηιέγνπκε ην πξόγξακκα defrag.exe. 
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Δηθόλα 7-5 

Δπηιέγνπκε ηε ζπρλόηεηα κε ηελ νπνία ζα πξαγκαηνπνηείηαη ε εξγαζία. 
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Γίλνπκε ηα ζηνηρεία ηνπ ρξήζηε κε ηα νπνία ζα πξαγκαηνπνηείηαη ε 

ρξνλνπξνγξακκαηηζκέλε εξγαζία. 

 

Αθήλνπκε λα αλνίμνπλ νη πξνρσξεκέλεο ξπζκίζεηο. 
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Δηθόλα 7-6 

ηηο πξνρσξεκέλεο ξπζκίζεηο πξνζζέηνπκε ηελ θαηάηκεζε ζηελ νπνία ζέινπκε 

λα θάλνπκε αλαζπγθξόηεζε. 

 

Δηθόλα 7-7 
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Μπνξνύκε επίζεο λα πξνζζέζνπκε θαη άιιεο ξπζκίζεηο από ηηο δηαζέζηκεο ηεο 

εθαξκνγήο. 

 

Δηθόλα 7-8 

Η ρξνλνπξνγξακκαηηζκέλε εξγαζία εκθαλίδεηαη ζηε ιίζηα εξγαζηώλ, απ‟ όπνπ 

κε μεμί θνπκπί ηνπ πνληηθηνύ επηιέγνπκε Run, ώζηε λα δνθηκάζνπκε άκεζα πσο 

ε εξγαζία εθηειείηαη ζύκθσλα κε ηηο επηζπκεηέο ξπζκίζεηο. 

 

Δηθόλα 7-9 
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8 Dependency Walker 

Έλα ρξήζηκν εξγαιείν ησλ Support Tools ησλ Windows είλαη ν Dependency 

Walker, κε ην νπνίν εληνπίδνληαη βηβιηνζήθεο ζπλαξηήζεσλ πνπ πξέπεη λα 

θνξησζνύλ θαηά ηε ιεηηνπξγία κηαο εθαξκνγήο θαη αλαιύνληαη ηα πηζαλά 

πξνβιήκαηα πνπ πξνθύπηνπλ ζηηο αλσηέξσ δηαδηθαζίεο. 

Σν εξγαιείν μεθηλά από Start/Run: “depends.exe”. 

 

Δηθόλα 8-1 

Από File → Open επηιέγνπκε ην αξρείν ηνπ νπνίνπ ζέινπκε λα βξνύκε ηηο 

εμαξηήζεηο από άιια αξρεία (π.ρ. βηβιηνζήθεο dll): 
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Δηθόλα 8-2 

 

Δηθόλα 8-3 

Γηα παξάδεηγκα, δηαπηζηώλνπκε όηη ν explorer.exe εμαξηάηαη από πνιιά dll 

αξρεία θαη κπνξνύκε λα δνύκε πιεξνθνξίεο γηα θαζέλα από απηά: 
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Δηθόλα 8-4 
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9 Έλεγχοσ δίςκων - HD Tune 

Έλα ρξήζηκν εξγαιείν γηα ηε κέηξεζε απόδνζεο, ηελ επηζθόπεζε πιεξνθνξηώλ 

θαη ηνλ έιεγρν ηεο θαηάζηαζεο ησλ ζθιεξώλ δίζθσλ γηα ιάζε είλαη ην HD Tune 

(http://www.hdtune.com , freeware v2.55). 

 

Δηθόλα 9-1 

Από ηελ θαξηέια Info κπνξνύκε λα δνύκε πιεξνθνξίεο γηα ηνπο ζθιεξνύο 

δίζθνπο: 

 

Δηθόλα 9-2 

Από ηελ θαξηέια Health κπνξνύκε λα δνύκε πιεξνθνξίεο γηα ηα SMART 

attributes ησλ ζθιεξώλ καο δίζθσλ. Μία νξζή αλάγλσζε απηώλ καο επηηξέπεη 

http://www.hdtune.com/
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λα αμηνινγήζνπκε ηελ πγεία ησλ ζθιεξώλ δίζθσλ (Status: Ok). Δλ νιίγνηο, 

ηδηόηεηεο πνπ έρνπλ κε κεδεληθό θαηώθιη (Σhreshold) ζα πξέπεη λα έρνπλ 

κεδεληθέο ηηκέο ζηα δεδνκέλα (Data). 

 

Δηθόλα 9-3 

Από ηελ θαξηέια Error Scan κπνξνύκε λα εμεηάζνπκε ην δίζθν γηα bad sectors: 

 

Δηθόλα 9-4 
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Αμίδεη λα ζεκεηώζνπκε όηη ζηηο Δπηινγέο (Options), κπνξνύκε λα αιιάμνπκε ηηο 

παξακέηξνπο ηνπ Benchmark ηνπ ζθιεξνύ δίζθνπ, ώζηε λα είλαη πην αθξηβέο ή 

λα νινθιεξώλεηαη γξεγνξόηεξα: 

 

Δηθόλα 9-5 
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10 Έλεγχοσ μνήμησ - RMMA 

Σν RightMark Memory Analyzer (http://cpu.rightmark.org/products/rmma.shtml) 

παξέρεη πιεξνθνξίεο γηα δηάξζξσζε ηεο κλήκεο ηνπ ζπζηήκαηνο, ελώ παξέρεη 

θαη εξγαιεία ειέγρνπ ηεο κλήκεο γηα ιάζε. 

 

Δηθόλα 10-1 

Γηα παξάδεηγκα, ζηελ θαξηέια SPD βιέπνπκε αλαιπηηθόηαηεο πιεξνθνξίεο γηα 

ηνλ θαηαζθεπαζηή ηεο κλήκεο θαη ηα ηερληθά ραξαθηεξηζηηθά ηεο: 

http://cpu.rightmark.org/products/rmma.shtml
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Δηθόλα 10-2 

ηελ θαξηέια RAM Performance κπνξνύκε λα πξαγκαηνπνηήζνπκε κέηξεζε ηεο 

απόδνζεο ηεο κλήκεο ηνπ ζπζηήκαηόο καο: 

 

Δηθόλα 10-3 

ηελ θαξηέια RAM Stability κπνξνύκε λα πξαγκαηνπνηήζνπκε έιεγρν ηεο 

ζηαζεξόηεηαο ηεο κλήκεο ηνπ ζπζηήκαηόο καο: 
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Δηθόλα 10-4 

Έλα αθόκα εθηειέζηκν αξρείν ηνπ πξνγξάκκαηνο είλαη ην rmms.exe, ην νπνίν 

καο παξέρεη έλαλ όκνξθν γξαθηθό ηξόπν γηα ηνλ έιεγρν ηεο ζηαζεξόηεηαο ηεο 

κλήκεο ηνπ ζπζηήκαηόο καο: 

 

Δηθόλα 10-5 
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11 Σημεία εκκίνηςησ προγραμμάτων - AutoRuns 

Σν AutoRuns ηεο SysInternals (http://technet.microsoft.com/en-

us/sysinternals/default.aspx) είλαη εθαξκνγή γηα ηελ εύξεζε όισλ ησλ ζεκείσλ 

πνπ είλαη δπλαηό λα θνξηώλεηαη έλα πξόγξακκα θαηά ηελ εθθίλεζε ησλ 

Windows. Σν AutoRuns είλαη πνιύ ρξήζηκν όηαλ πξνζπαζνύκε λα θαζαξίζνπκε 

έλα ζύζηεκα κνιπζκέλν από θαθόβνπιν ινγηζκηθό. 

 

Δηθόλα 11-1 

Μπνξνύκε λα έρνπκε ηόζν κηα επνπηηθή εηθόλα γηα ό,ηη εθθηλείηαη θαηά ηελ  

έλαξμε ησλ Windows, όζν θαη νκαδνπνηεκέλα αλά θαηεγνξίεο. 

Γηα παξάδεηγκα, κία ελδηαθέξνπζα θαξηέια είλαη ε Winlogon, κηαο θαη πνιιά 

θαθόβνπια ινγηζκηθά επηιέγνπλ λα θνξησζνύλ καδί κε ην winlogon process: 

http://technet.microsoft.com/en-us/sysinternals/default.aspx
http://technet.microsoft.com/en-us/sysinternals/default.aspx
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Δηθόλα 11-2 

Γηα θάζε εγγξαθή κπνξνύκε κε δεμί θιηθ λα επηιέμνπκε είηε “Search Online”: 

 

Δηθόλα 11-3 

θαη λα δνύκε πιεξνθνξίεο από Google γηα απηό ην αξρείν: 
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Δηθόλα 11-4 

είηε Properties θαη λα δνύκε πιεξνθνξίεο από explorer γηα απηό ην αξρείν. 

 

Δηθόλα 11-5 
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12 Διαχείριςη Διεργαςιών - Process Explorer 

Έλα εμαηξεηηθό εξγαιείν πνπ κνηάδεη κε Task Manager αιιά δηαζέηεη πνιύ 

πεξηζζόηεξεο δπλαηόηεηεο ν Process Explorer ηεο SysInternals 

(http://technet.microsoft.com/en-us/sysinternals/default.aspx). Σν εξγαιείν απηό 

είλαη πνιύ ρξήζηκν όηαλ πξνζπαζνύκε λα θαζαξίζνπκε έλα ζύζηεκα κνιπζκέλν 

από θαθόβνπιν ινγηζκηθό. 

 

Δηθόλα 12-1 

ην θάησ κέξνο ηνπ παξαζύξνπ κπνξνύκε λα δνύκε πιεξνθνξίεο γηα ηε 

δηεξγαζία πνπ έρνπκε επηιέμεη ζην πάλσ κέξνο: 

http://technet.microsoft.com/en-us/sysinternals/default.aspx
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Δηθόλα 12-2 

Με δεμί θιηθ ζηηο ζηήιεο θαη επηιέγνληαο “Select Columns” έρνπκε ηε δπλαηόηεηα 

λα εκπινπηίζνπκε ηηο εκθαληδόκελεο πιεξνθνξίεο. Γηα παξάδεηγκα, κπνξνύκε λα 

επηιέμνπκε ηε ζηήιε “Verified Signer”: 

 

Δηθόλα 12-3 
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Δπηιέγνληαο ηώξα Options → Verify Image Signatures γίλεηαη έλαο δηθηπαθόο 

έιεγρνο γηα ηηο δηεξγαζίεο ηνπ ζπζηήκαηνο, ώζηε λα πξνζδηνξηζηεί αλ ηα αξρεία 

πνπ ηξέρνπλ είλαη απζεληηθά ή όρη: 

 

Δηθόλα 12-4 

Με δεμί θιηθ θαη επηιέγνληαο Properties: 

 

Δηθόλα 12-5 
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κπνξνύκε λα δνύκε ηηο ηδηόηεηεο ηνπ αξρείνπ, νξγαλσκέλεο ζε πνιύ ρξήζηκεο 

θαξηέιεο: 

 

Δηθόλα 12-6 

Ο ρξσκαηηθόο θώδηθαο ησλ εκθαληδόκελσλ δηεξγαζηώλ κπνξεί λα ηξνπνπνηεζεί. 

Οη εμ νξηζκνύ επηινγέο θαίλνληαη ζηελ αθόινπζε εηθόλα. Ιδηαίηεξε πξνζνρή 

πξέπεη λα δνζεί ζηα “Packed Images”, δηόηη ζηελ πιεηνςεθία ησλ πεξηπηώζεσλ 

ππνθξύπηνπλ ηελ ύπαξμε θάπνηνπ θαθόβνπινπ ινγηζκηθνύ: 

 

Δηθόλα 12-7 
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13 Δομημένη Καλωδίωςη 
13.1 Καταςκευή καλωδίου UTP Category 5 / 5E 

Τπάξρνπλ δύν εηδώλ patch cords ηα straight (επζύ) θαη ηα crossover 

(αλεζηξακκέλα). Σα πξώηα ρξεζηκνπνηνύληαη γηα ηελ ζύλδεζε ππνινγηζηώλ ζε 

switches θαη ηα δεύηεξα ρξεζηκνπνηνύληαη γηα ηελ ζύλδεζε switches κεηαμύ 

ηνπο. Οξηζκέλα switches ππνζηεξίδνπλ ηελ δηαζύλδεζε κε άιια switch θαη κε 

straight patch cords ρξεζηκνπνηώληαο ηελ ιεηηνπξγία MDI/MDX. 

Σα απαξαίηεηα εξγαιεία θαη πιηθά πνπ ρξεηάδεηαη λα δηαζέηνπκε γηα λα 

θηηάμνπκε έλα patch cord είλαη ηα εμήο (Δηθόλα 8): 

 Μία πξέζα γηα RJ-45 δηεπαθέο 

 2 connectors RJ-45 

 1 utp θαιώδην 

 Έλα απνγπκλσηή θαισδίσλ ή ιεπίδη (πξναηξεηηθά) αλ δελ έρεη ηελ 

δπλαηόηεηα ε πξέζα γηα ηελ απνγύκλσζε ηνπ θαισδίνπ. 

 

Δηθόλα 8: Τιηθά γηα ηελ θαηαζθεπή ελόο utp patch cord. 

Τπάξρνπλ δύν πξόηππα γηα ηελ δεκηνπξγία ελόο utp θαισδίνπ ην 568-A θαη 

568-B. Απηά ηα πξόηππα έρνπλ λα θάλνπλ κε ηνλ ηξόπν πνπ ηνπνζεηνύληαη ηα 

θαιώδηα ζην RJ-45 connector θαη είλαη ηζνδύλακα. Πην θνηλό ζηελ ρξήζε είλαη 

ην πξόηππν 568-B. Η παξαθάησ εηθόλα δείρλεη ηελ δηαθνξά ζηελ ηνπνζέηεζε 

ησλ θαισδίσλ αλάκεζα ζηα δύν πξόηππα. 
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Καλωδίωζη 568-B 

 

Ζεσγάρι # Καλώδιο 
Pin 
# 

1-

Άσπρο/Μπλε 

Άσπρο/Μπλε 5 

Μπλε 4 

2-
Άσπρο/Πορτ. 

Άσπρο/Πορτ. 1 

Πορτοκαλί 2 

3-
Άσπρο/Πρασ. 

Άσπρο/Πρασ. 3 

Πράσινο 6 

4-
Άσπρο/Καυέ 

Άσπρο/Καυέ 7 

Καυέ 8 

< Διάγραμμα 568-B 
 

 

Καλωδίωζη 568-A 

 

Ζεσγάρι # Καλώδιο 
Pin 
# 

1-

Άσπρο/Μπλε 

Άσπρο/Μπλε 5 

Μπλε 4 

2- 
Άσπρο/Πρασ. 

Άσπρο/Πρασ. 1 

Πράσινο 2 

3- 
Άσπρο/Πορτ. 

Άσπρο/Πορτ. 3 

Πορτοκαλί 6 

4-
Άσπρο/Καυέ 

Άσπρο/Καυέ 7 

Καυέ 8 

< Διάγραμμα  568-A 
 

Δηθόλα 9: Γηαθνξέο κεηαμύ 568-A θαη 568-B 

 

Γηα ηελ δεκηνπξγία ελόο straight θαισδίνπ ζα πξέπεη νη δύν άθξεο λα 

αθνινπζνύλ ην ίδην πξόηππν, ελώ γηα ην crossover ζα πξέπεη λα θαισδησζνύλ ε 

κία κε ην 568-Α θαη ε άιιε κε ην 568-Β. 

 

Οδηγίες Καηαζκεσής Καλωδίοσ Patch Cable 

1. Απνγπκλώλνπκε κε ηελ βνήζεηα ηνπ απνγπκλσηή ή ηεο ιεπίδαο ην 

εμσηεξηθό πεξίβιεκα ηνπ θαισδίνπ θαηά πεξίπνπ 4 εθαηνζηά. 

 

2. θάζε δεύγνο θαισδίνπ θαη ηζηώζηε ηα θαιώδηα.  

3. Γηαηάμηε ηα θαιώδηα κε ηε ζσζηή ζεηξά ζύκθσλα κε ηα δύν 

δηαγξάκκαηα (568B ή 568A). Φέξηε ηα θαιώδηα παξάιιεια θνληά ην έλα 
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ζην άιιν, κέρξη λα εθάπηνληαη. ε απηό ην ζεκείν ειέγμηε όηη ε ζεηξά ησλ 

θαισδίσλ είλαη ζύκθσλε κε ην δηάγξακκα. 

4. Κξαηήζηε ζηαζεξά ηα νκαδνπνηεκέλα θαη δηαηεηαγκέλα θαιώδηα καδί 

αλάκεζα ζηνλ αληίρεηξα θαη ζηνλ δείθηε. 

 

5. Κόςηε όια ηα θαιώδηα, κε ηε βνήζεηα ελόο ςαιηδηνύ ή ηνπ θόθηε πνπ έρεη 

ε πξέζα, έηζη ώζηε ην κέησπό ηνπο λα είλαη επίπεδν θαη θάζεην σο πξνο 

ην θαιώδην. Σν κήθνο ησλ θαισδίσλ ζα πξέπεη λα είλαη πεξίπνπ 1,3 

εθαηνζηά από ηελ άθξε ηνπ απνγπκλσκέλνπ πεξηβιήκαηνο.  

 

6. Δηζάγεηε ηα θαιώδηα κέζα ζην βύζκα (κε ηελ κεξηά ησλ pins λα θνηηάεη 

πξνο ηα πάλσ). 
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7. Πηέζηε ζρεηηθά δπλαηά ηα θαιώδηα κέζα ώζηε λα εμαζθαιίζεηε όηη όια 

ηα θαιώδηα έρνπλ θηάζεη κέρξη ην ηέξκα ηνπ βύζκαηνο. Φξνληίζηε ώζηε 

ην πξνζηαηεπκέλν κέξνο ηνπ θαισδίνπ λα εηζέιζεη κέζα ζην πίζσ κέξνο 

ηνπ βύζκαηνο θαηά πεξίπνπ 0,5 εθαηνζηό. 

 

8. Σνπνζεηήζηε ηελ άθξε ηνπ θαισδίνπ κε ην βύζκα κέζα ζην εηδηθό 

εξγαιείν-πέλζα θαη ζθίμηε δπλαηά κέρξη ε ιαβή λα θηάζεη ζην ηέινο ηεο 

δηαδξνκήο ηεο. 

 

9. Δπαλαιάβεηε ηελ ίδηα δηαδηθαζία θαη γηα ην άιιν άθξν. Γηα έλα θαλνληθό 

straight θαιώδην, ρξεζηκνπνηήζηε ηελ ίδηα θαισδίσζε. Γηα έλα 

αλεζηξακκέλν "crossover" θαιώδην, θαισδηώζηε ην έλα άθξν σο 568A, 

θαη ην άιιν σο 568B. 

10. Έλαο γξήγνξνο έιεγρνο γηα ηελ νξζή ιεηηνπξγία ηνπ θαισδίνπ είλαη λα ην 

ρξεζηκνπνηήζεηε ζε κηα ππάξρνπζα ζύλδεζε θαη λα ειέγμεηε αλ ν 

ζηαζκόο εξγαζίαο ζπλδέεηαη ζην δίθηπν κε ην θαιώδην απηό 

ρξεζηκνπνηώληαο ηελ εληνιή ping. 

11. Γηα λα βεβαησζνύκε όηη ην θαιώδην πνπ θηηάμακε πιεξνί ηηο 

πξνδηαγξαθέο ηνπ cat5/cat5e πξνηύπνπ ζα πξέπεη λα ρξεζηκνπνηήζνπκε 

έλα cable tester πνπ παξέρεη απηνύ ηνπ είδνπο ηνλ έιεγρν. 

13.2 Οδηγίεσ ελέγχου utp καλωδίων 

ην παξαθάησ θείκελν παξνπζηάδνληαη νδεγίεο γηα ηνλ έιεγρν ηεο νξζήο 

ιεηηνπξγίαο ησλ patch cords πνπ έρνπκε δεκηνπξγήζεη. 

Γηα ηνλ έιεγρν ησλ θαισδίσλ ζα ρξεζηκνπνηεζνύλ νη δύν ζπζθεπέο ηεο Agilent 

ην WireScope 350 θαη ην DualRemote 350 (βι. Δηθόλεο 1 θαη 2) 
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Δηθόλα 10: WireScope 350 

 

Δηθόλα 11: DualRemote 350 

Οη ζπζθεπέο απηέο κπνξνύλ λα πξαγκαηνπνηήζνπλ έλα κεγάιν αξηζκό από 

ειέγρνπο θαισδίσλ όπσο ραιθνύ θαη  νπηηθά. ην ζπγθεθξηκέλν θείκελν ζα 

δείμνπκε πσο κπνξνύκε λα ειέγμνπκε αλ ην θαιώδην πνπ θαηαζθεπάζακε 

ιεηηνπξγεί νκαιά θαη πιεξνί ηηο πξνδηαγξαθέο ηεο θαηεγνξίαο 5e θαη 6. 

Γηα ηελ πξαγκαηνπνίεζε θαη ησλ δύν ειέγρσλ γηα ηα θαιώδηα UTP ζα πξέπεη λα 

ρξεζηκνπνηεζνύλ νη θαηάιιεινη πξνζαξκνγείο γηα ηηο δηεπαθέο RJ45 (βι. Δηθόλα 

12) 
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Δηθόλα 12: Πξνζαξκνγείο γηα RJ45 

1. Κατ’ αρχιν ςυνδζουμε τουσ προςαρμογείσ ςτισ ςυςκευζσ και ζπειτα ςυνδζουμε το  
καλϊδιο που κζλουμε να ελζγξουμε ςτισ υποδοχζσ των προςαρμογζων. 

2. Στο κεντρικό μενοφ επιλζγουμε το κουμπί Autotest 

 

3. Στθ ςυνζχεια πατάμε το κουμπί Select Settings Profile για να επιλζξουμε τθν 
κατθγορία προδιαγραφϊν που κα ςυγκρικοφν τα αποτελζςματα των μετριςεων 
του καλωδίου. Στθν ςυγκεκριμζνθ περίπτωςθ επιλζγουμε τθν κατθγορία Default 
Cat5e. Μόλισ επιλεγεί θ κατθγορία πατάμε το πλικτρο ΟΚ 
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4. Στθ ςυνζχεια ςτθν οκόνθ που εμφανίηεται επιλζγουμε το Start Test για να ξεκινιςει 
ο ζλεγχοσ του καλωδίου για τθν κατθγορία 5e. 

 

5. Με τθν ολοκλιρωςθ του ελζγχου βγαίνουν τα αποτελζςματα αν το καλϊδιο πλθροί 
τισ προδιαγραφζσ τθσ κατθγορίασ που επιλζχκθκε και εμφανίηεται θ αντίςτοιχθ 
οκόνθ.  Οι ζλεγχοι που γίνονται είναι οι εξισ: 

a. Wire-map 
b. Distance 
c. NEXT 
d. Attenuation 
e. Return Loss 
f. ELFEXT 

 

6. Με το πζρασ του ελζγχου δίνεται θ δυνατότθτα να αποκθκεφςουμε τα 
αποτελζςματα ςτθν μνιμθ τθσ ςυςκευισ και να τα αντιγράψουμε ςτον υπολογιςτι 
μασ με τθν μορφι pdf αρχείου. 
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Οη ζπγθεθξηκέλνη έιεγρνη πνπ γίλνληαη κε ηελ δηαδηθαζία ηνπ Autotest κπνξνύλ 

λα γίλνπλ θαη κεκνλσκέλα από ην κελνύ Tools ηεο ζπζθεπήο WireScope. Δπίζεο 

κπνξεί λα ειεγρζεί ζε πνηα δίθηπα κπνξεί λα ιεηηνπξγήζεη ην θαιώδην πνπ 

θαηαζθεπάζακε (π.ρ. 10Base-T, 100Base-T, 1000Base-T, 155 Mbps ATM θ.α.) 
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14 Αςκήςεισ 

1. Γηακνξθώζηε κία Κνλζόια Γηαρείξηζεο, ώζηε εθηόο ησλ εξγαιείσλ 

δηαρείξηζεο πνπ πεξηιακβάλνληαη ζην Computer Management, λα 

πεξηιακβάλεη θαη ην εξγαιείν ηεο ξύζκηζεο πνιηηηθώλ ηνπ ζηαζκνύ 

εξγαζίαο. 

2. Δληνπίζηε ηα events πνπ ζρεηίδνληαη κε ηε δηαδηθαζία 

εγθαηάζηαζεο/απεγθαηάζηαζεο/δηακόξθσζεο εθαξκνγώλ. 

Γηαθνξνπνηνύληαη αλάινγα κε ηελ επηηπρή ή κε έθβαζε ησλ αλσηέξσ 

δηαδηθαζηώλ; 

3. Δληνπίζηε έλα Error ζηελ θαηαγξαθή ζπκβάλησλ θαη αλαιύζηε ηελ αηηία 

πνπ ην πξνθάιεζε. Πξνρσξήζηε ζε δηνξζσηηθέο ελέξγεηεο. 

4. Δληνπίζηε ηελ ππεξεζία κε ηελ νπνία ιεηηνπξγνύλ ηα Event Logs θαη 

επηβεβαηώζηε πσο έρεη μεθηλήζεη. 

5. Γεκηνπξγήζηε έλα ρξνλνπξνγξακκαηηζκέλν task, κε ην νπνίν ζε κεληαία 

βάζε θαζαξίδεη ν ππνινγηζηήο από άρξεζηα αξρεία. 

6. Δίζηε ζηελ επηηξνπή νξηζηηθήο παξαιαβήο λένπ ΔΠΔΗΤ κεηά από 

δνθηκαζηηθή ιεηηνπξγία 30 εκεξώλ. Πώο ζα ειέγμεηε πσο ν εμνπιηζκόο 

δελ αληηκεησπίδεη πξνβιήκαηα ιεηηνπξγίαο. 

7. Καηαζθεπάζηε έλα patch cord UTP Cat 5E θαη ειέγμηε ηελ νξζή 

θαηαζθεπή θαη ιεηηνπξγία ηνπ. 


